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Query Operators 

=My Operator 

  This operator is used to require that the contents of the field match the value of a field in the 

user’s record. For example, the comparison might test for Department =My Department. 

Only records with the same department as the user are included. You don’t have to compare 

the same fields. For example, the comparison might test for City =My Contact 1 City. Only 

records with the same City as the user’s Contact 1 City are included. The record being 

checked for the user will be either the user’s employee record or applicant record, depending 

on the user’s status. 

In and Not In Operator 

These operators dramatically simplify queries when you are comparing multiple values in the 

same field. For example, the complex query below:   

Department  =  100 OR  

Department  =  300 OR 

Department  =  500  

is replaced by the simple query below: 

Department  In  100, 300, 500   

The Not In operator works conversely. 

Anniv and Anniv-M Operators 

These  operators have been added for use with date fields. With the Anniv operator, the 

month and day have to match. With the Anniv-M operator, only the month has to match. 

These operators would typically be used with date variables and when scheduling reports. 

Query on Derived Fields: Derived fields can be used in queries.  Thus, you could use the 

Three Percent Increase field in a query and do a search as follows: 

Three Percent Increase  >=  $40,000.00 

If there are any employees whose salary would be greater than or equal to $40,000.00 

following a three percent increase, they would meet the criteria set by the query and appear as 

results on the report. 

Date Variables: Now work with the Between operator.  

Click to Paren: You can click on the Open and Close parentheses columns to insert or delete 

the respective parentheses symbols rather than using the keyboard.  
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Report Definitions 

Spacing Field: There are now five spacing options: 1, 1.5, 2, 2.5, and 3.  

Alignment Field: Documents can now be left-justified or centered using a new field on the 

Specifications tab.   The default is determined by a setting in Enterprise Setup. 

Field and Row Modifiers 

The Mod column on the Report Definition screen was split into two. There are now Row 

Modifiers and Field Modifiers. Row modifiers determine which rows from a multi-row 

screen are to be output.  Field modifiers determine which part of the field is to be output or 

how the field is to be modified on output. Field modifiers are only available on date and 

currency fields. If you try to select a field modifier for other field types, a message will 

appear stating that there are no valid modifiers. 

Modifier Description Sample Output 

M Numeric month 1 to 12 

D Numeric day of the month 1 to 31 

Y Numeric year 2008 

WD Word day of the week Monday, Tuesday, etc. 

WM Word month December 

WMD Word month and day December 31 

WMDY Word month, day and year December 31, 2008 

W$ Word currency Twenty three and 0/100 Dollars 

 

When existing reports are converted, applicable field modifiers will be moved to the new 

column and the appropriate row modifier will be set. For example, if the M modifier has been 

used, the Field Modifier will be set to M and the Row Modifier will be set to 1.  

#:#  (range of rows) 

This new modifier is used to specify that a range of rows is to be included. The range is 

formed from a “from value” and “to value” separated by a colon. For example, if you wish to 

print the pay rate from rows 2 through 5, use the field name and range modifiers as shown 

below. 

Pay Rate 2:5 

There are no limits to the range you can enter. If you specify an upper value that exceeds the 

number of rows, only the number of actual rows is returned. If the starting value is above the 

number of rows, no rows are returned. If you enter the range in reverse order (larger number 

first), the range will corrected when you leave the field. 
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Sorting and Calculations 

Email 
The new Email Eject break allows you to email portions of a document to the appropriate 

owner. For example, if you email eject on the employee email address, you can email a group 

of letters all at once with each letter being emailed to the appropriate employee. Likewise, if 

you email eject on the manager email address, you can cause the appropriate pages of a large 

report to be emailed to the appropriate manager. Note that you can only email eject on email 

address fields. When you select an Email field, there is an additional entry in the support 

table for the Sort column. This is the Email sort type. It functions just like the Eject sort, but 

provides the special email eject capability when a document is emailed.  

Percent Count 
This calculation type is used to calculate the percentage of the count of the number of records 

within a break. For example, if you do a percent count calculation on the Full Name field that 

is broken by the Department Code field, the report will list the percent of the total count for 

each department. 

Percent Total 
This calculation type is used to calculate the percentage of the total (sum) of the numeric 

values within a break. For example, if you do a percent total calculation on the Pay Rate field 

that is broken by the Department Code field, the report will list the percent of the total salary 

burden for each department. 
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Notes 
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New Document Types 

Archived Documents  
The new Archived Documents document type allows you to run and maintain documents that 

have been archived via the Output to Archive feature. The archived document is stored in the 

database. 

Cluster Reports 
 The new Cluster Report document type allows you to run several documents (labels, letters, 

reports, forms, standard reports) together as a group, without having to select and run each 

document separately. This feature is particularly valuable if you tend to run a series of 

documents at the end of each month, or merely on a frequent basis. 

The Cluster Report option uses a two-tab screen. The Specification tab is used to record the 

name of the cluster and the categories for the cluster. The Documents tab is used to define the 

documents to include in the Cluster Report.  

Email 
 An Email option has been added to the Documents menu to allow you to define an email 

specification much like a document specification. This option allows you to create and send 

an email without having to be in a record group.  

When you create a new or open an existing email specification, the Email screen is displayed, 

which uses four tabs. The Specification tab is used to define basic information about the 

email as well as specify the recipients. The Query tab contains the standard query grid to 

determine for whom the email specification is going to be sent. The Message tab is used to 

specify the message portion of the email. The Attachments tab is used to define what 

attachments to include in the email. 

Forms 
There is a new Forms document type that allows you to combine a form and a query to 

produce a set of output forms. There are standard forms provided by People-Trak that allow 

you to output information on attendance balances, benefits enrollment, and compensation 

history as well as other information.   

Freeform Report 
 There is a new Freeform Reports feature that enables you to create reports using a SQL 

statement. This will normally be used when you wish to create a complex report that cannot 

be accommodated with the standard Adhoc Report Writer. It will also enable us to create 

reports that we can send you to meet unique requirements.  

The Freeform Reports feature bypasses all field security. If a user is allowed to create a 

Freeform Report, he or she can access any field within People-Trak. For this reason, there are 

special security settings for the Freeform Reports feature. You can allow users to create 

and/or run freeform reports in Security Setup. 

The Freeform Reports option uses a three-tab screen. The Specification tab is similar to the 

Adhoc Report screen and is used to define basic information about the document. The SQL 
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Statement tab contains a single text box for entering the SQL statement. The Report Captions 

tab contains a grid for entering captions and formatting formulas.  

Updated Document Properties 

Email Tab 
Emails can be sent to various email address from the Address Book as well as to any named 

Position.  In addition, you can now specify the email distribution list using a query. If you are 

accustomed to using the Lookup favorite feature in People-Trak to quickly select records for 

editing or for batches, you can now use these same favorites to specify dynamically selected 

email distribution lists. For example, if you have a favorite that selects those employees in a 

given department and you use that favorite as an email distribution list, the list of employees 

to receive the email will be dynamically selected at the moment the email is sent. If a new 

member was added to that department just seconds before you email, that member will be 

sent the email.  

The Encrypt on Send checkbox allows you to specify whether or not you want to encrypt the 

document when sending it via email. Encryption is recommended for a document with 

sensitive information on it. If this check box is selected, the document will be encrypted and 

password protected when attached to an email. The recipient will receive an email informing 

them of the password for the document that is sent in a separate email. 

Note: The Email tab is not available for an Export or Lookup Favorite document as there is 

no document actually produced. 

Spanning Tab 
The Spanning tab is used to activate company spanning. Documents are normally produced 

using a query that selects records from the current company. With company spanning, you 

can cause any document to select records from a collection of companies, not just the current 

company. For example, if you wish to run a report that includes records from both the active 

and the archive databases, you can specify these databases with the company spanning 

feature. Whenever this document is run, it will collect applicable records from both 

companies. 

Company spanning is not used by default. In other words, if you do not specify company 

spanning, the current company is used.  

In Freeform reports, spanning is done by default so no Spanning tab is available. 

Note: Spanning is only available to Administrators for security purposes, so when non-

administrators run a document that spans, they will only see information for the current 

company and based on their given security. 

Cover Sheet Tab 
The Cover Sheet tab is used to specify the Cover Sheet template to use, if you choose, for 

your documents. If a cover sheet has been selected for a document, the cover sheet is 

automatically pre-pended to that document as a single page document when the document is 

ran. When the properties page is displayed for a document type that does not support cover 

sheets (Export and Lookup Favorites) the Cover Sheet tab is not displayed. In the case of 

cluster reports, you can specify a cover sheet for the whole cluster, and if any reports 

included in the cluster have a cover sheet, their cover sheets will be printed in their respective 

places. 
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Annotations Tab 
The Annotations tab is used to specify a customized header and/or footer notation to be 

placed on a document. If the properties page is displayed for a document type that does not 

support headers and footers, the Annotations tab is not displayed. 

In addition to designating the desired header and footer for the document, there are 

checkboxes to specify whether the header and footer are repeated on each page or are on the 

first page only. 

Note: If a cover sheet is part of the document, annotations will show up on the actual 

document, not the cover sheet. 

Document Viewer  

Output to Image 
With the Output to Image option you can now output the current page of a document to an 

image file.  

Output to Archive 
Allows you to archive the current document you are viewing. When selected, an Output to 

Archive screen is displayed in which you can enter a description and category for the 

archived document. The document can be viewed again later using the Archived Documents 

option on the Documents menu. 

Output to Email 
If a document uses the new Email break feature, you are notified upon choosing the Output to 

Email option that this break exists and you are given the option of continuing or not. If you 

continue, portions of that document are emailed to the appropriate owners, and you are 

notified that those emails were sent. As before, the Output to Email screen will be displayed 

with any email addresses that were specified in the Document Properties, and you can add 

additional email addresses at that time, if required.  

New Key Functions 
The Home and End keys move to the first page and last page of the document, respectively. 

The arrow keys scroll in larger increments for faster viewing.  The Down Arrow and Up 

Arrow keys can now be used to scroll through the document and behave just like the arrows 

on the vertical scroll bar. There are zoom buttons on the toolbar. 

Record Bar 
When a document contains forms or letters (one per record), a record bar is displayed to aid 

in navigation between the records.  You can drop down a list of the records that have been 

qualified or you can use the Next, Previous, First, or Last buttons to navigate. If the letter is a 

multi-page document, the Page buttons (Next, Previous, First, and Last) are used to move 

between the pages of the letter.  
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Template Features 

Template Editor 
The template editor has been enhanced. You are now able to save your work during an 

editing session, add background color, redo an undone change, and take advantage of other 

interface enhancements that make the editor easier to use. 

Template Field Row Modifier 
In a few places in People-Trak, there are one-to-many-to-many data relationships. For 

example, on the Benefits screen, a plan in the Benefit Plan Enrollment grid can have multiple 

enrolled dependents in the Enrolled Dependents grid. If you want to do a benefits form for an 

employee listing the enrolled plans including dependents in each plan, you not only need to 

specify the row modifier for the plan, but also the row modifiers for the dependents in that 

plan. When inserting a field in a template, you now have the ability in the Row Modifier field 

to put in Row.SubRow. For example, if you wanted to see the dependents in the first benefit 

plan, you would insert fields with a row modifier of 1.1, 1.2, 1.3, and so on. 

Email Templates 
You can now define email templates like other letter templates. These templates can be 

specified for use wherever an email is created throughout People-Trak. All relevant mail-

merge is performed into the template so that each email is personalized.  

Form Templates 
There is a new Form Template process that allows you to create complex form templates for 

output purposes. You can easily add fields, frames, grids and other objects to create output 

documents with any information from within People-Trak. You have the option of selecting a 

PDF form as a background. Then, using a drag and drop tool, you can position the fields and 

other objects at the appropriate location on the form. When the form template is complete, 

you can create documents based on the form template by using the Forms option on the 

Documents menu. A special option in this feature enables you to decide if you wish to 

actually print the form background, if there is one. If you have preprinted forms such as 

numbered forms, you can use the imported form to layout and maintain the form. However, at 

print time, you can cause the data only to be printed, thus placing the appropriate data at the 

appropriate locations on your form without the form background. 

There are standard forms provided by People-Trak that allow you to output attendance 

balances, benefits enrollment, compensation history, and other information. It is possible to 

convert an existing custom screen into a form template with just a few clicks. 

Letter and Label Templates 
These have updated screens that show details about the template and a description that 

defines the purpose the template.  There are minor changes to the template editor.  You can 

now use images in templates and can select fields from the database that translate to images 

when merged (i.e. Employee Photo). 

Letter and Label Utilities 
There are new utilities to enable you to create new standard sizes for letters and labels or to 

tweak settings so that labels work more accurately on your printer 
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System Templates 

This process on the Administration menu allows Administrators to create templates that use 

system fields, which can then be used across all modules. There are four types of templates as 

described in the sections below. An unlimited number of each of the four template types can 

be defined by the user.   

Cover Sheet 
Cover Sheet templates are single page documents that are automatically pre-pended to 

documents when they run. The template enables you to create the cover sheet just the way 

you want it. When the Cover Sheet Template Editor opens, you are given the space for a full 

page and you can format as desired. You can include tables and pictures as well. Cover 

Sheets are assigned to a document under the Cover Sheet tab in Document Properties. 

Note: Cluster Reports are reports that are composed of a “cluster” of other reports. When the 

cluster is run, each report is run individually and then merged into a single final document. 

You can specify a cover sheet for the entire cluster and it will be at the front of the first 

document. However, if you have specified cover sheets for any of the individual documents 

in the cluster, these will also be included in their respective places. 

Email Closing 
Email Closing templates can be used when sending emails from within People-Trak. The 

Send Email screens used throughout People-Trak allows you to specify either a template 

(fully formatted as desired) or enter a basic block of text. Email Closing templates can only 

use text fields, so image fields such as logo and signature cannot be used. If you want to have 

more elaborate emails using those fields, use the Email Template feature on the Templates 

menu and assign an email template to an email rather than using the simple block of text 

closing. Email Closings are assigned in User Setup. 

Note: The Email Closing Template will always use fields related to the current user, even if 

the sender specified in the From field is different.  If a user wants a more fully formatted or 

specific email, they can use an email template instead which supports the full spectrum of 

HTML formatting capabilities. 

Header and Footer  
A number of the People-Trak document types (Adhoc Reports, Freeform Reports, Standard 

Reports, etc.) utilize a header and footer. The header currently includes the logo and three 

fields regarding the document itself: company name, document title and document comment. 

You are also able to specify where these two blocks are positioned. The Header Note can be 

placed in the third unused space. The Footer Note will always be placed in the center area. 

Headers and Footers are assigned to a document under the Annotations tab in Document 

Properties. 

The main System Templates screen is similar to the Letter Template screen, except it includes 

a Template Type field. Each of these templates uses the standard text editor.  

System Template Editor  

Use the Edit Template option on the File menu or the Edit Template button on the Tool Bar 

to access the System Template Editor, which uses the standard Text Editor interface.  

Within the editor, there is a change in the ability to select mail merge fields. In these four 

template types, only the system merge fields can be used. These include many fields from the 

company and current user, but would not include anything from employee record, applicant 
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record, etc because these are not relevant. Other than Email Closing template, it is possible to 

specify the field that represents the user signature and company logo. The user signature (and 

other user fields) would be taken from the User Table for regular HR users in People-Trak 

and would be taken from the Employee table for ESS users
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This lesson covers how to use the Explorer when working with documents. The Explorer 

organizes all of your documents into categories in the same way that the Windows Explorer 

organizes files into folders. 

Tutorials 
Retrieve and Print a Document: shows two methods for retrieving and printing documents. 

Create a Document: demonstrates how to start the creation of a document using the 

Explorer. The document is completed using the appropriate document editor. 

Delete a Document: shows how to delete any obsolete document. 

Copy a Document: demonstrates how to make a copy of a document. 

Working with Categories: shows how to change categories for a single document and for all 

documents. It also shows how to merge the documents from one category into another. 
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Tutorial 1.1 – Retrieve and Print a Document 

People-Trak provides a large number of pre-defined reports that you can use. In this tutorial, 

you will learn how to select and print a document. 

1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop 

(or as instructed).  

 

The Select Product Option screen is displayed.  

2. The Position Control and Attendance options should be the only options that are 

toggled on. If not select the Training button to select them. 

3. Click OK 

 

The Login screen is displayed. 

4. In the User ID field, enter DEMO. 

5. In the Password field, enter DEMO. 

 

The Organizer desktop is displayed with the Personnel Management module selected.  

6. On the Documents menu, select Adhoc Reports.  

 

The Explorer is opened and all of the existing adhoc reports are organized by explorer 

category. The explorer category is assigned when a document is created and can be 

changed if necessary. We’ll use the explorer categories to help us find a report. 

7. Select the Compensation category to display a list of the compensation documents.  

8. Highlight Salary History by Employee in the list but do not open it.  

 

At this point, you can open the document to run it or you can run it directly from the 

Explorer. As usual, we will try both. 

9. On the File menu, select Open Adhoc Report or on the Tool Bar, click the Open Adhoc 

Report button to open the Salary History by Employee document.  

 

The document opens and the Adhoc Reports screen displays. This screen is used to 

create, edit, and run documents.  

 

Note: You are also able to open documents by double-clicking on the document name if 

the Run on Double-Click option is not turned on for the user in User Setup. 

10. We do not need to change the document, so click the Run Adhoc Report button on the 

Tool Bar to run the document.  

 

The document displays in the Document Viewer. 

Note: Whenever you see the Run/Edit button  on any Tool Bar, you can perform that 

function by pressing the F5 key. 

11. Close the Document Viewer and close the Adhoc Reports screen.  
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12. This time, run the document directly from the Explorer by clicking the Run Adhoc 

Report button on the Tool Bar.  

 

The document is sent to the Document Viewer as before.  

13. Close the Document Viewer. 

14. Select the General category and run the Employee List by Department report.  

 

As you can see, to run existing reports you need only point and click.  

15. Close the Document Viewer and the Explorer. 

 

Let’s look at another type of document, the Letter. 

16. On the Documents menu, select Letters. 

 

The Explorer is opened and all of the existing letters are organized by explorer category. 

17. Select the Physical Letter and run it.  

 

A physical letter for each record in the company is generated and sent to the Document 

Viewer.   

18. Close the Document Viewer and the Explorer. 

19. On the Documents menu, select Standard Reports.  

20. Select the Workforce category. 

21. Select the Workforce Distribution by Ethnicity report and run it.  

 

This report is a colorful graph that illustrates the number of employees within each ethnic 

category. Notice that at the bottom of the screen, the legend is displayed. This legend 

contains the numbers and percentages represented by the graph.  

22. Close the Document Viewer and the Explorer. 

 

There are many, many documents that you can run. Some may be helpful and some may 

not. Using the navigation features you have learned, you can find these documents and 

test print them in order to determine which are the most useful to you. 

23. Continue with the next tutorial.   
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Tutorial 1.2 – Create a Document 

The Explorer is the starting point for creating new documents. Fully creating new documents 

is the subject of multiple future lessons. In this tutorial, we will show you how to get started. 

1. On the Documents menu, select Letters. 

 

The Explorer is opened and all of the existing letters are organized by explorer category. 

2. On the File menu, select New Letter or on the Tool Bar, click the New Letter button to 

create a new letter. 

 

The Letters screen is displayed. A new letter has been created in the <Blank Category> 

category and should have a name of NEW-1. If NEW-1 had already existed, this value 

would be NEW-2 and so on.  

 

Note: The Letters screen is used to specify the document name, categories, letter 

template, sort order, and query equations for the letter. Completing all of these fields is 

outside the scope of this lesson. We will complete just enough fields to continue.  

3. In the Document Name field, enter My Letter.  

 

The next field is the Explorer Category, which is the category that this document will be 

in when in the Explorer. You can create an unlimited number of explorer categories. 

4. In the Explorer Category field, enter My Category. When asked if you want to override 

the table, click Yes.  

 

The next field is Category, which is the category that is used throughout People-Trak to 

secure items as well as specify where the item should be shown in the Categories pane of 

the Organizer desktop. When you create a document, this is defaulted to User but can be 

changed to any pre-defined category. 

5. We will leave the Category set to User. 

6. In the Letter Name field, use the popup button to select Physical Letter.  

7. On the Tool Bar, click the Run Letter button to show that you have created a valid letter 

document. Close the Document Viewer. 

 

The changes you made are no longer in the modified color. This is because all documents 

are saved first and then run. 

8. Close the Letters screen. 

 

The Explorer is displayed. The new category, My Category, is highlighted on the left and 

your new document, My Letter, is highlighted on the right. 

9. Run the My Letter document directly from the Explorer.  

 

The letters will be generated as before. Once created, a new letter document is just like 

any other document.  

10. Close the Document Viewer and continue with the next tutorial. 
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Tutorial 1.3 – Delete a Document 

This tutorial demonstrates a simple function that you probably won't need for some time. 

However, after an extended period of time when you have created dozens and dozens of 

documents, you may decide to delete some. To show you how to do this, we are going to 

delete the letter document created in the last tutorial. 

1. The My Letter document should still be highlighted. 

2. On the File menu, select Delete Letter or on the Tool Bar, click the Delete Letter button 

to delete the document.  

 

The following message is displayed: 

Delete the Letter specification highlighted and listed below? 
 
My Letter 

3. Click Yes to delete the document. 

 

Because there was just one document in the category, the category is also deleted. This 

only happens when the last document in a category is deleted.  

4. Close the Explorer. 

5. Continue with the next tutorial. 
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Tutorial 1.4 – Copy a Document 

There are times when it is useful to make a copy of an existing document. For example, if 

you have a document that you wish to use as a model for a similar document, you can copy 

the document and then modify the copy. In addition, if you wish to make a document 

common, but keep a copy of your own, you can copy the document and make the copy 

common. Use the following procedure to copy a document. 

1. On the Documents menu, select Adhoc Reports. 

2. In the General category, highlight the Alphabetic Employee List document. 

3. On the File menu, select Copy Adhoc Report to place a copy of the document in 

memory.  

 

A copy of the document is placed in the list. It is titled Alphabetic Employee List-1. This 

copy of the Alphabetic Employee List document is completely distinct and can be 

modified or deleted without affecting the original document.  

4. To prove this, delete this “-1” document using what you learned in the last tutorial. 

5. Close the Explorer. 

6. Continue with the next tutorial. 
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Tutorial 1.5 – Working with Categories 

Categories are normally assigned when a document is created. To change a category after a 

document has been created, select the document for editing, change the category field, and 

then save the document. Try it now. 

1. On the Documents menu, select Adhoc Reports. 

2. In the General category, open the Home Phone List document.  

3. Change the Explorer Category to Education.  

4. Close the Adhoc Reports screen, saving your changes. 

 

The Home Phone List document is moved from the General category to the Education 

category.  

 

You can change the category to an entirely new category if you wish. Try that now.  

5. In the Education category, open the Home Phone List document again.  

6. Change the Explorer Category to My Category, overriding the table. Close the Adhoc 

Reports screen, saving your change. 

 

A new category is created and the Home Phone List is placed in it. 

 

You can change the category for all documents in a category using the Explorer. Here’s 

how.  

7. Highlight the General category.  

8. On the File menu, select Rename Category. 

 

The Rename Category screen is displayed. 

9. In the New Category field, enter New Category and click Rename. 

 

The change takes place immediately and all related documents are permanently changed. 

There is no General category any longer. 

 

You can merge one category with another category as well. Try this technique.  

10. Change the Education category to New Category using what you just learned. 

 

Because the category already exists, the following message is displayed: 

This category has already been used. Do you wish to combine categories? 

11. Click Yes to merge the categories.  

 

The documents from Education are merged with the documents from New Category. The 

Education category is now gone. 

 

Now that we are done playing with categories, let’s get the documents back where they 

belong.  
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12. In the New Category category, open the Educational History by Employee document. 

Change the Explorer Category back to Education. Close the Adhoc Reports screen, 

saving your change.  

13. In the My Category category, open the Home Phone List document. Change the 

Explorer Category back to General. Close the Adhoc Reports screen, saving your 

change. 

14. In the Explorer, change New Category back to General.  

15. Close the Explorer.  

16. This concludes this tutorial and lesson. 
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All documents produced by People-Trak are sent to the Document Viewer. The Document 

Viewer is used to preview documents and to output documents not only to the printer, but 

also to a variety of other destinations. 

Some of the features in the Document Viewer will only work if you have the appropriate 

product installed. For example, columnar-style reports can be exported directly into Microsoft 

Excel (or to a similar product associated with the XLS extension). If you do not have Excel or 

an equivalent product installed, this feature will not work. 

This lesson covers how to use the Document Viewer. 

Tutorials 
Navigating a Document: shows how to use the navigation features to move through the 

pages of a document. 

Viewing, Zooming and Scrolling: demonstrates some techniques for changing the viewing 

attributes of a document. 

Output Options: shows how to output documents to destinations other than just the printer. 
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Tutorial 2.1 – Navigating a Document 

Most documents that you print will be more than one page in length. When a document is 

longer than one page, you need to know how to navigate through the pages. That’s the 

purpose of this tutorial. 

1. On the Documents menu, select Adhoc Reports.  

 

The Explorer screen for adhoc reports is displayed. 

2. In the Compensation category, select the Salary History by Employee report and run it.  

 

A multi-page report is created.  

 

There are four blue navigation buttons on the Tool Bar. The outer buttons are used to 

jump to the first and last pages respectively.  

3. Click these outer buttons now. 

 

The page counter and the document contents indicate the page you are on. The HOME 

and END keys can also be used to perform the First Page and Last Page functions. 

 

The inner buttons are used to jump to the previous and next pages respectively. If you are 

on the last page and click the Next button, you will cycle around to the first page. If you 

are on the first page and click the Previous button, you will cycle around to the last page. 

4. Click these inner buttons now. 

 

The PAGE UP and PAGE DOWN keys can also be used to perform the Previous Page 

and Next Page functions when viewing a whole page. When a partial page is displayed 

like you have right now, these keys will scroll up/down a third of the current page. You 

can try this if you like.  

5. Close the Document Viewer and the Explorer. 

 

The Document Viewer is a little different when letters and forms are displayed.  

6. On the Documents menu, select Letters. 

7. Select Physical Letter and run the letters. 

 

One single-page letter should be generated for each employee. You can see by the text 

between the navigation buttons on the Tool Bar that page 1 of 32 is currently displayed. 

This is the total number of pages in the document, one for each employee. If there had 

been two pages per employee, the counter would say 1 of 64. 

 

Note that there is an additional toolbar now displayed. This is the Record Navigation Bar. 

It is used to move through the individual letters for each employee. There are four 

navigation buttons. The outer buttons are used to jump to the first and last records.  

8. Click these outer buttons now.  

 

The record counter and the record dropdown indicate which record you are viewing. 

 

The inner buttons are used to jump to the previous and next records respectively.  
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9. Click these inner buttons now.  

 

The record counter will confirm that you are moving forward or backward through the 

records. The previous and next buttons wrap like the page buttons did.  

 

The Record dropdown can be used to move immediately to any desired record.  

10. In the Record dropdown, select Rhoda Tyrell and display her letter.  

 

You can just as easily select any record in the query result.  

11. Keep the Document Viewer open. 

12. Continue with the next tutorial. 
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Tutorial 2.2 – Viewing, Zooming and Scrolling 

Documents in the Document Viewer can be viewed in a number of ways and the document 

image can be zoomed for optimal resolution. Let’s learn how. 

 

When a document is first displayed, the view is defaulted to Page Width, which displays the 

document so that the width of the page fills the available space. The length of the document 

can then be viewed using the scroll bar. There are four other view options. These are listed in 

the View dropdown on the Tool Bar. We’ll try each.  

1. In the View dropdown, select the Percentage option to show the document in a percent-

of-size mode.  

 

When this option is selected the Percentage dropdown is enabled. You can use the 

Percentage dropdown to change the size of the document.  

2. Try each of the sizes to see which one you like best. 

3. Select the Thumbnail option.  

 

This shows each page in the document in a very small size and is not all that useful. If 

you are viewing a letter or form, the view shows each page in the selected record. If the 

letter is a single page, only a single page will be shown. If viewing an adhoc report, a 

group of pages will be shown. 

4. Select the Two Pages option.  

 

This shows two pages at a time. It is very useful when you have a two-page letter and you 

wish to see both pages. If a letter has only one page (regardless of the number of records), 

just one page is shown. 

5. Select the Whole Page option.  

 

This adjusts the size of the document so that a full page of the document is visible at 

once. Depending on the size of your monitor and the resolution, this may be a useful 

option.  

6. Select the Page Width option to return to the default view mode.  

 

Now let’s take a look at the zooming options. 

 

Zooming In makes the document image larger and is performed using the Zoom In (+) 

button on the Tool Bar. Each click of the button makes the image larger by zooming in 

one percentage setting, which corresponds to the settings in the Percentage dropdown. 

7. On the Tool Bar, click the Zoom In button to make the image larger.  

 

The first click will change the viewing percentage from the Page Width setting of 125% 

to the next percentage setting of 150%. 

8. Keep clicking that button to make the document really large.  

 

You will find that you cannot go past 400%, which corresponds to the maximum setting 

in the Percentage dropdown. 

 



Using the Document Viewer 

 

 What’s New in Documents and Reporting     23 
 

Zooming Out makes the document image smaller and is performed using the Zoom Out 

(-) button on the Tool Bar. Each click of the button makes the image smaller by zooming 

out one percentage setting, which corresponds to the settings in the Percentage dropdown. 

9. On the Tool Bar, click the Zoom Out button to make the image smaller. Keep clicking 

that button to make the document really small.  

 

You will find that you cannot go lower than 25%, which corresponds to the minimum 

setting in the Percentage dropdown. 

 

To zoom in or out, you can also double-click on the document itself using the left or right 

mouse button. 

10. Try double-clicking with the left mouse button and then the right mouse button to see 

how this performs the same actions as the Zoom In and Zoom Out keys. 

 

Whenever a document image is larger than the screen, scrolling is enabled. You can 

scroll a document to show the hidden part using the scroll bar at the right of the screen.   

11. In the View dropdown, select the Page Width option to return to the default view mode. 

Then use the scroll bar to view the rest of the page. When you reach the end of the page, 

keep clicking the down arrow on the scroll bar and you will continue on to the next page. 

 

As with all scroll bars, the square that moves shows you where you are on that page. 

12. Now, use the UP ARROW and DOWN ARROW keys to scroll up and down.  

 

You can also use the mouse wheel (if your mouse is so lucky to have one) to scroll up 

and down. 

13. Use the mouse wheel to scroll up and down. 

 

You can also drag the mouse to see the rest of the page. 

14. Click and hold down the left mouse button and move the document up and down using 

the mouse. 

 

The cursor will change to a hand as you move the document. You can also move the 

document left and right if the page is wider than the display. 

15. In the View dropdown, select Percentage. In the Percentage dropdown, select 200%. 

 

The document is made that much larger. 

16. Position the cursor over the document and move the document left and right using the 

mouse. 

 

Note that you also have a horizontal scroll bar in addition to the vertical scroll bar. 

17. Use the horizontal scroll bar to move the document left and right. 

 

As you have seen, there a number of ways to view a document. You will find the ways 

that work best for you. 

18. Close the Document Viewer and the Explorer. 
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19. Continue with the next tutorial. 
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Tutorial 2.3 – Output Options 

One of the most powerful capabilities of the Document Viewer is the ability to output 

documents to destinations other than just a printer. Let’s try these options now. 

1. On the Documents menu, select Adhoc Reports. 

2. In the Compensation category, select the Salary History by Employee document and 

run the report.  

 

This is the document we will use to demonstrate output options. The output options are 

listed as buttons on the Tool Bar and as options on the File menu. There are eight options: 

to printer, to spreadsheet, to word processor, to PDF viewer, to HTML viewer, to image 

viewer, to archive, and to email.  

 

On all output options except Output to Printer and Email, a temporary file is created and 

loaded into the software product associated with the appropriate extension. When you 

close the product and the Document Viewer, the temporary file will be deleted. If you 

want to modify the document, you need to use the “Save As” feature in the associated 

product, rename the file and save it in a new location. If you modify the document, the 

changes are NOT saved back into People-Trak. You are working on a copy of data taken 

from People-Trak, not live data. 

 

The printer option is self-explanatory; we have all printed a document to a printer before. 

Let’s start with the spreadsheet option. 

 

The spreadsheet option is used to output the document to Microsoft Excel, or to a similar 

product that is associated with the XLS file extension. When this option is selected, a 

temporary XLS file is created from the document. The product associated with XLS files 

is then started and the file is automatically loaded.  

3. On the Tool Bar, click the Output to Spreadsheet button to output the document to a 

spreadsheet.  

 

After a brief delay, you will see your document displayed in Excel (or similar product). 

You can use Excel against this file to perform any desired task.  

 

Note: If you get a dialog box stating that the file is in a different format than specified by 

the file extension, just click Yes. This is to be expected in more recent versions of Excel. 

4. Close the spreadsheet and then click the Output to Spreadsheet button again.  

 

Note that the spreadsheet loads much more quickly. This happens because Windows 

leaves parts of the spreadsheet program in memory.  

5. Close the spreadsheet.  

 

Note: The Output to Spreadsheet option only works with documents that are formatted as 

rows and columns. Letters, labels, forms, screen prints and standard reports cannot use 

this option. As a result, cluster reports cannot be output to a spreadsheet product. Adhoc 

reports in tabular format will be output as if they were in columnar. Microsoft Excel can 

save documents in a wide variety of formats. When you need to create a file for another 

purpose in one of these formats, simply create a document that contains the data you 

need, output the document to Excel and then use Excel to save the document in the file 
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format you need. 

 

The Output to Word Processor option is used to output the document to Microsoft Word, 

or to a similar product that is associated with the RTF file extension (i.e. WordPad). 

When this option is selected, a temporary RTF file is created from the document. The 

product associated with RTF files is then started and the file is automatically loaded. 

6. On the Tool Bar, click the Output to Word Processor button to output the document to 

a word processor.  

 

After a brief delay, you will see your document displayed within Word (or similar 

product). If the document is a row and column document, the document is placed into a 

“table”. If the document is a letter or labels, the document is presented as simple 

paragraphs. You can use Word against this file to perform any desired task.  

7. Close the word processor. 

 

Note: Forms, screen prints and standard reports cannot be output to Word or other word 

processing products. As a result, cluster reports cannot be output to a word processing 

product. 

 

The Output to PDF Viewer option is used to output the document to Adobe Reader, or to 

a similar product that is associated with the PDF file extension. When this option is 

selected, a PDF file is created from the document. The PDF viewer is then started and the 

file is automatically loaded.  

8. On the Tool Bar, click the Output to PDF Viewer button to output the document to a 

PDF viewer.  

 

After a brief delay, you will see your document displayed within your PDF viewer. PDF 

files can be read by the PDF viewer, but are not editable. The usual reason for creating a 

PDF document is to send the document to someone else via email or another method. 

Once loaded, you can save the document from within the PDF viewer. 

9. Close the PDF viewer. 

 

The Output to HTML Viewer is used to output the document to your web browser, or to a 

similar product that is associated with the HTM file extension. When this option is 

selected, a temporary HTM file is created from the document. The product associated 

with HTM files is then started and the file is automatically loaded.  

10. On the Tool Bar, click the Output to HTML Viewer button to output the document to 

an HTML viewer.  

 

After a brief delay, you will see your document displayed within your HTML viewer. 

The HTML viewer does not usually have edit capabilities, but you can use it to save the 

document as a web page.  

11. Close the browser.  

 

Note: Forms and standard reports cannot be output to an HTML viewer. As a result, 

cluster reports cannot be output to an HTML viewer. 

 

The Output to Image Viewer option is used to output the document to Windows Picture 

and Fax Viewer, or to a similar product that is associated with the EMF (Enhanced 
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MetaFile) file extension. When this option is selected, a temporary EMF file is created 

for the current page of the document. The image viewer is then started and the file is 

automatically loaded.  

12. On the Tool Bar, click the Output to Image Viewer button to output the document to an 

image viewer.  

 

After a brief delay, you will see the current page of your document displayed within your 

image viewer. If the document was output to Windows Picture and Fax Viewer, you can 

then open the image for editing in Microsoft Paint. If the document was output directly to 

an image editor such as Microsoft Paint or Paintshop Pro, the image can then be edited. 

13. Close the image viewer. 

 

The Output to Archive option is used to archive a document for future reference.  

14. On the Tool Bar, click the Output to Archive button. 

 

The Output to Archive screen is displayed. You have the option of changing the name of 

the document, adding a description and assigning a category. Since we have already 

covered selecting categories, we will show you how to do the first two tasks. 

15. In the Document Name field, add today’s date to the end of the field.  

 

This might be something you want to do to easily see when that document is archived. 

Your naming policy is up to you. 

 

As you can see, the Category for this document has been defaulted to Compensation. We 

will leave this as is. 

 

The description field can be used to add further information about this archived 

document. We’ll just put some simple text there to show you where you can find this 

information later. 

16. In the Description field, enter Archive Description. 

 

The rest of the fields are for information purposes and are display only. 

17. Close the Output to Archive screen, saving your changes. 

We will go see where this went in just a minute. Let’s look at one more output option 

first. 

The Output to Email option is used to output the document to email recipients. When a 

document is sent to email, the document is automatically converted to a PDF file.  

18. On the Tool Bar, click the Output to Email button to start the email process.  

 

The Send Email screen is displayed. The title of the document is put in the Subject field 

on the Message tab. The document is converted to a PDF file and the path to that file is 

put in the Attachment 1 field on the Attachments tab. You will learn more about this 

Send Email screen in later training. 

19. Close the Send Email screen. 
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Any document that you create in People-Trak is always sent to the Document Viewer for 

visual inspection. From the Document Viewer, you can decide if you need to print or 

output the document to another destination. You will often not need to actually print the 

document, so you can save the paper for another day! 

20. Close the Document Viewer, the Adhoc Reports screen and the Explorer.  

 

Now, let’s go see where that archived document went. 

21. On the Documents menu, select Archived Documents. 

 

The Explorer for Archived Document screen is displayed. The Categories for which 

documents have been archived are listed on the left. The All Documents category is 

highlighted and all of the archived documents are displayed on the right. 

22. On the File menu, select Run Archived Document or on the Tool Bar, click the Run 

Archived Document button. 

 

The document you archived is opened in the PDF viewer and includes the data that 

existed at the point in time you performed the output to archive.  

23. Close the Document Viewer. 

24. Close the Explorer. 

25. This concludes this tutorial and lesson. 
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This lesson covers other document types that are available in People-Trak: Standard Reports, 

Cluster Reports and Freeform Reports. It also covers the Spanning tab and Description field 

on the Document Properties screen. 

Tutorials 
Standard Reports: shows how to create a standard report, which is a report with a pre-

defined format. Also shows how you can change the query for a standard report. 

Cluster Reports: demonstrates how to create a cluster report, which is a report that allows 

you to run several documents together as a group. 

Freeform Reports: shows how to create a freeform report, which allows you to enter an 

SQL statement and a series of captions to create reports that you could not otherwise create. 

Spanning: demonstrates how to use spanning of companies on a document. 
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Tutorial 3.1 – Standard Reports 

Standard Reports are those reports that have a pre-defined format. You can determine what 

employee records are to be included in the report, but the layout of the report is already set. 

Let’s create a standard report. 

1. On the Documents menu, select Standard Reports. 

 

The Explorer for Standard Reports is displayed. 

2. On the Tool Bar, click the New Standard Report button to create a new document. 

3. In the Document Name field, enter My Gender Graph. In the Explorer Category field, 

enter whatever category you desire. Leave the Category field set to User.  

 

A standard report document is composed of a standard report template and a query 

(which could be blank). So, we must select a report template in the Standard Report field. 

4. In the Standard Report field, click the popup button to display a list of the existing 

report templates. Select the Workforce Distribution by Gender template.  

5. Click the Query tab. 

 

As expected, there are no query equations. So, if we run the report, we will see all records 

in the current company, including those that might be terminated or inactive.  

6. Run the standard report. 

 

The report is a pie chart that graphically indicates the gender makeup of the company. In 

this instance, it is all employees in the company regardless of status.  

7. Scroll down to see the details that support the graph.  

8. Close the Document Viewer.  

 

Now, let’s enhance the document by adding a query. 

9. On the Query tab, enter the simple equation shown below. 

 

Gender  = Male 
 

This query will limit the employee records in the report to those whose Gender is Male. 

10. Run the report. 

 

The graph should indicate that a report that queries only males should list only males. 

11. Close the Document Viewer.  

12. This time, change the query to the more meaningful equation below.  

 

Active  = Y 

13. Now run the report.  
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This report will provide a chart with all currently active employees. Now that’s a useful 

report. 

14. Close the Document Viewer and the Standard Reports screen. 

15. Close the Explorer. 

16. Continue with the next tutorial.  
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Tutorial 3.2 – Cluster Reports 

Cluster Reports allow you to run several documents together as a group, without having to 

select and run each document separately. This feature is particularly valuable if you tend to 

run a series of documents at the end of each month, or merely on a frequent basis.  

1. On the Documents menu, select Cluster Reports. 

 

The Explorer for Cluster Reports is displayed. 

2. On the Tool Bar, click the New Cluster Report button to create a new document. 

3. In the Cluster Name field, enter Monthly Reports. In the Explorer Category field, 

enter whatever category you desire. Leave the Category field set to User. 

4. On the Documents tab, click the popup button. 

 

The Select Document screen is displayed. Notice that Cluster Reports is not listed in the 

list of document types in the upper left pane. This is because cluster reports cannot 

include another cluster reports. You can choose from all other document types. We will 

select an Adhoc Report. 

5. Stay in the currently highlighted Adhoc Reports type. Select the Compensation 

category in the list of categories in the lower left, and then select the Salary History by 

Employee document in the list on the right. Click OK to return that document to the 

Documents grid. 

 

Let’s add two more Adhoc Reports to our cluster report. 

6. On the next row of the grid, use the popup and select the Attendance Balances by 

Account document from the Attendance category. Keep going and add the Headcount 

by Department document from the Headcount category. 

 

We can mix document types in a cluster report. Let’s add a letter. 

7. On the next row of the grid, use the popup and select Letters in the list of document 

types. Now, select the Welcome Letter document in the list on the right. Click OK to 

return that letter to the Documents grid.   

8. Run the cluster report.  

 

Each document is processed independently and you may be able to see the progress bar 

for each. When the documents are complete, they are merged together and then shown 

within the Document Viewer.  

 

The documents are discrete within the Document Viewer. The page counter on the Tool 

Bar reflects the total number of pages in the cluster report, but each document’s pages are 

numbered from 1 to the total number of pages in the document. Font settings, alignment, 

spacing, and grid lines are all unique to each document.  

9. Move through the pages of the cluster report and you can see that each document is 

unique.  

 

Letter, Label and Form documents will not include a Navigation Bar because a cluster 

report can include several different types of documents. The Cluster Report feature is 
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intended to provide an easy way of outputting several documents; it is not intended to be 

used for interactive purposes. In addition, the Output to Spreadsheet option is not 

available. 

 

If you choose to print the cluster report, one stream of pages will be printed. 

10. Close the Document Viewer and the Cluster Reports screen.  

11. Close the Explorer. 

12. Continue with the next tutorial.  
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Tutorial 3.3 – Freeform Reports 

Freeform reports allow you to enter an SQL statement and a series of captions to create 

reports that you could not otherwise create. Normal use of this feature requires specific 

knowledge of SQL and internal knowledge of the People-Trak database. Such knowledge is 

beyond the scope of this tutorial, but we can show how the feature works and what you can 

do with it.  

The Freeform Reports feature bypasses all field security. If a user is allowed to create a 

freeform report, they can access any field within People-Trak. For this reason, there are 

special security settings for the freeform reports feature. We’ll explore these first. 

1. On the Setup menu, select Security Setup. 

 

On the General tab, there are two fields that control use of the Freeform Reports feature. 

The Create Freeform Reports field grants the ability to create these reports, and this is the 

ability that must be carefully used. If a user can create Freeform Reports, they can view 

virtually any information in People-Trak. 

 

The Run Freeform Reports field grants the ability to run freeform reports, but not to 

create them. So, it is possible to have some users with appropriate clearance create 

reports that can then be run by other users. Of course, it is important that the reports that 

are given to other users do not contain protected information. 

 

In order to see how these security settings work, we need to have the DEMO user not be 

an Administrator because an Administrator bypasses all security settings. 

2. Clear the Administrator check box for the DEMO user. 

3. Clear the Create Freeform Reports and Run Freeform Reports check boxes. 

4. Close the Security Setup screen, saving your changes. 

5. Open the Documents menu. Note that Freeform Reports is not listed as an option. 

6. Return to Security Setup and select the Create Freeform Reports check box for the 

DEMO user. Close the Security Setup screen, saving your changes. 

7. Open the Documents menu. Note that Freeform Reports is now listed as an option. 

Select Freeform Reports and let’s get started. 

8. On the File menu, select New Freeform Report or on the Tool Bar, click New 

Freeform Report. 

 

The Freeform Reports screen is displayed. This screen contains three tabs. The 

Specification tab is similar to the Adhoc Reports screen. The SQL Statement tab contains 

a single text box for entering the SQL statement. The Report Captions tab contains a grid 

for entering captions and formatting formulas. 

9. In the Document Name field, enter SQL Test Report. In the Explorer Category field, 

enter whatever category you desire. Leave the Category field set to User. 

10. On the SQL Statement tab, enter the following SQL statement. 

 

Select Name_Last, Name_First from PMMain 
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11. Run the report.   

 

Can’t find the Run option? There is a good reason for this. You still have the Run 

Freeform Report check box cleared for your DEMO user in Security Setup. This means 

you cannot run Freeform reports. Let’s change that. 

12. Close the Freeform Reports screen, saving your changes. Close the Explorer. 

13. Return to Security Setup and select the Run Freeform Reports check box for the 

DEMO user. Close the Security Setup screen, saving your changes. 

14. On the Documents menu, select Freeform Reports. Open your SQL Test Report 

document and then run it.  

 

This report lists the last name and first name for each employee in the database. There 

was no restriction on companies, so all employees in all companies are listed. (SQL 

statements are a type of programming; they do what you tell them to do and nothing 

more.)  

 

As you can see in the Document Viewer, there are no captions in the report. We can fix 

this.  

15. Close the Document Viewer. 

16. On the Report Captions tab, enter two Captions: Last Name and First Name.  

 

The two fields on our report do not need any formatting, so we will leave the Format 

column blank. 

17. Run the report again.   

 

It should look much better with these captions.  

18. Close the Document Viewer.  

 

As indicated above, there is insufficient scope to teach SQL, but to whet your appetite to 

learn more on your own, we’ll show a few other tricks.  

19. On the SQL Statement tab, clear the existing SQL statement, and enter the following:  

 

Select Avg(Age) from PMMain 
 

This statement will calculate the average age of all employees.  

20. Run the report.  

 

You can see that there are two problems. First the caption is wrong and second, there are 

too many digits to the right of the decimal point. We can fix both.  

21. Close the Document Viewer.  

22. On the Report Captions tab, change the first Caption to Average Age and delete the 

second Caption. Set the Format column for the first row to “#.00”.   

 

This will simplify the display to just two decimal places. 
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23. Run the report and you can see the fruits of your efforts.  

 

The combination of SQL statements and People-Trak formatting capabilities can allow 

those with a working knowledge of SQL to create a very wide range of reports. In certain 

instances, your Support Representative will provide a Freeform Report solution for you 

should the two of you be unable to create the desired report with the Adhoc Reports tool. 

24. Close the Document Viewer, the Freeform Reports screen and the Explorer. 

 

Before we leave, we need to get DEMO set back to Administrator. 

25. Return to Security Setup and select the Administrator check box for the DEMO user. 

Close the Security Setup screen, saving your changes. 

26. Continue with the next tutorial. 
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Tutorial 3.4 – Spanning 

Now we are going to switch gears a bit and look at document properties that you have not yet 

learned about. The first one is document spanning where you can have documents span 

multiple companies at your discretion. Here is how you do it. 

1. On the Documents menu, select Adhoc Reports. 

2. Create a new Adhoc Report named All Employees and place it in any Explorer 

Category you desire. Leave the Category field set to User. 

3. Leave the Query tab blank, but add two fields to the Report Definition tab: Employee 

ID and Full Name. Add a Count calculation on the Full Name field so that we can count 

the records.   

4. Run the report and note the number of records that qualify.  

5. Close the Document Viewer and the Adhoc Reports screen. 

 

Your new report should be highlighted in the Explorer. 

6. On the File menu, select Adhoc Report Properties or on the Tool Bar, click the Adhoc 

Report Properties button to display the properties for this document. 

 

The Adhoc Report Properties screen is displayed for this document. 

7. Click the Spanning tab.  

 

This tab provides a grid in which to record the companies that are to be spanned. In this 

case, the grid is blank. When you ran the report, however, records were displayed and 

counted. Why? Because when there is no company specified, the report will be run for 

the current company only. Once you specify one or more companies, the report will be 

run for those companies regardless of which company is the current company. 

8. Close the Adhoc Report Properties screen and close the Explorer. 

9. Use what you already know to transfer the following three records from the ACTIVE 

company to the ARCHIVE company. 

 

1017 Anna Belamonte 

1019 Helen Pilsner 

1020 Renee Watanabe 

10. Close any open records to return to the Organizer desktop. 

11. On the File menu, select Select Company and switch to the ARCHIVE company. 

Confirm that the three records have been transferred. Return to the ACTIVE company. 

12. On the Documents menu, select Adhoc Reports. 

13. Find and highlight the All Employees report you created earlier in this lesson. Run the 

report from the Explorer.  

 

There should be three less records than there were before because we moved three 
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records from the ACTIVE company to the ARCHIVE company, and we are currently in 

the ACTIVE company. 

14. Close the Document Viewer and the Explorer.  

15. On the File menu, select Select Company and switch to the ARCHIVE company. 

16. Open your report and run it again.  

 

How many records are shown this time? There should be as many records as there are in 

the current company, which is the ARCHIVE company. 

17. Close the Document Viewer.  

 

You can also access the Adhoc Report Properties screen from within the screen for the 

report itself. 

18. On the Adhoc Reports screen, use the Adhoc Report Properties option on the File 

menu or the Adhoc Report Properties button on the Tool Bar to display the Adhoc 

Report Properties screen. 

19. Click the Spanning tab. On the first line in the grid, click the popup button to display a 

list of the available companies. Select the ACTIVE company. Close and save the 

changes to the properties. 

20. Run the report again.  

 

This time, how many records are shown? Even though we are currently in the ARCHIVE 

company, all of the records from the ACTIVE company are shown because that is what 

the spanning instructions state. 

21. Open the Adhoc Report Properties screen again. On the Spanning tab, add the 

ARCHIVE company to the list of companies for our sample report. Close and save the 

properties. 

22. Run the report again.  

 

This time, all of the records in the ACTIVE and the ARCHIVE companies are shown. 

This will be true regardless of the company you are currently working in even if it is not 

one of the companies in the spanning list. 

23. Finally, use the Adhoc Report Properties screen to remove both of the companies from 

the spanning list. Now, run the report again, and it will contain the employees from the 

current company only. 

24. Close the Document Viewer, the Adhoc Reports screen and the Explorer. 

25. Transfer the three employees from the ARCHIVE company back to the ACTIVE 

company. 

26. Switch back to the ACTIVE company.  

 

Spanning is only available to Administrators for security purposes, so when non-

administrators run a document that spans, they will only see information for the current 

company and based on their given security. 
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27. This concludes this tutorial and lesson. 

 

  



Lesson 3 

 

40     What’s New in Documents and Reporting 

Notes 
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This lesson covers how to use the Explorer to create and modify templates. It also shows how 

to create documents from a template and a query as well as print labels for a group of 

employees during an editing session. The lesson concludes with a demonstration of how to 

copy a template. 

Tutorials 
Select and Modify an Existing Template: shows how to select an existing template and 

modify it. 

Create a Label Template: demonstrates how to create a new label template from scratch. 

Create and Print a Label Document: shows how to create a document from a label 

template and a query. Also demonstrates how to make a copy of a document. 

Print Labels for a Group: demonstrates how to print labels for a group of employees during 

an editing session. 

Copy a Template: shows how to copy an existing template and make changes to the new 

template copy. 
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Tutorial 4.1 – Select and Modify an Existing Template 

Within People-Trak, a document is defined as a template (or document design) and a query. 

The template determines what the document looks like and the query determines which 

records are to be included. In the tutorials in this lesson, we will be using label templates to 

demonstrate the basics of working with a simple template. These basics also apply to letter 

templates. We will use letter templates in the next lesson to show some advanced editing 

features. 

1. On the Templates menu, select Label Templates. 

 

The Label Templates screen is displayed. Label templates are displayed in the list on the 

left. The details for the highlighted template are shown on the right. 

2. Select Address Label - Avery 5160 in the list of templates on the left.  

 

The standard settings for this label template are displayed on the right. We want to use 

the standard 5160 label, so we will leave these settings as is.  

3. On the File menu, select Edit Label Template or on the Tool Bar, click the Edit Label 

Template button to start the text editor. 

 

When the Label Template Editor screen is displayed, note that the edit area has been 

sized to match Avery 5160 label.  

 

This label contains no literal text. It contains only fields. The fields are indicated by the 

~F~ placeholders.  

4. Move the cursor over one of the placeholders.  

 

The cursor icon switches to an arrow whenever you hover over a placeholder. You can 

use this feature to identify (and to optionally change) an existing field in a template. Try 

it now.   

5. Move the cursor over the first placeholder and then double-click.   

 

The Field Settings screen is displayed. It shows the name of the field and any applicable 

modifiers.  

6. Close the Field Settings screen and try another field. 

7. Close the Field Settings screen. 

 

You can also show all of the fields at once.  

8. On the Field menu, select Show Fields to display the field names.  

 

From the field names, it is clear that this is an address label.  

9. Select Show Fields again to change the field names back to placeholders.  

 

Now, let’s add the Country field to the label template. 

10. Click on the first line after the last placeholder.  
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11. On the Field menu, select Insert Field or on the Tool Bar, click the Insert Field (~F~) 

button to start the insert.   

 

The Field Settings screen is displayed. 

12. In the Field Name field, select Country. Click OK to insert the field. 

 

The national address label has now been switched to an international address label. 

13. Close the Label Template Editor screen, saving your changes.  

14. Close the Label Templates screen, saving your changes. 

15. Continue with the next tutorial. 
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Tutorial 4.2 – Create a Label Template 

In the last tutorial, you learned how to view and modify an existing template. In this lesson, 

you’ll create a template from scratch. Let’s get started. 

1. On the Templates menu, select Label Templates. 

2. On the Tool Bar, click the New Template button.  

3. In the Template Name field, enter My Big Label Template. 

 

The Label Type field allows you to pick the specific label type you want to use. People-

Trak is shipped with many standard label types. If you need to add label types, you can 

do so using the Maintain Label Types utility. 

4. In the Category field, select the Personal category. 

5. In the Label Type field, select Avery 5164.  

 

This is a somewhat larger label. 

6. On the Tool Bar, click the Edit Label Template button to start the text editor. 

 

When the Label Template Editor screen is displayed, the edit area is sized to reflect the 

actual size of the label. 

7. Because this is a large label, change the Font Size to 14. 

8. Press ENTER twice to move the cursor down two lines. 

 

Now let’s insert a field. 

9. On the Field menu, select Insert Field or on the Tool Bar, click the Insert Field (~F~) 

button to start the insert.   

 

The Field Settings screen is displayed. 

10. In the Field Name field, select Full Name. Click OK to insert the field. 

11. On the next line, insert the Address 1 field. 

12. On the next line, insert the Address 2 field. 

13. On the next line, insert the City, State Zip compound field. 

14. To customize your large label, change the font attributes on the Address 1 field to Bold, 

Italic, and Underline.  

 

Remember, you can do this by highlighting the field and then setting the attribute. 

15. Finally, to show that a template can contain text other than fields, press ENTER several 

times and add a line at the very bottom of the label that says: Bottom of the label. 

Note: You will need to use the right arrow at the City, State Zip field to get past it if 

there is no blank line under it yet.  
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16. Close the Label Template Editor screen, saving your changes. 

17. Close the Label Templates screen, saving your changes.  

18. Continue with the next tutorial.  
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Tutorial 4.3 – Create and Print a Label Document 

Now that we have created a template, it is time to create a document that uses that template. 

1. On the Documents menu, select Labels.  

2. On the Tool Bar, click the New Label button to create a new document.  

3. In the Document Name field, enter Label Using Big Label Template. 

4. In the Explorer Category field, select any desired category. Set the Category field to 

Personal. 

5. In the Label Name field, use the popup button to select the My Big Label Template we 

just created.  

6. Leave the Sort fields blank for the moment. 

7. Now run the label.  

 

You should have multiple pages with four labels per page. Move through the pages and 

enjoy your big label. It is truly something “big”. 

8. Close the Document Viewer. 

9. In the Sort By 1 field, select Last Name.  

10. Now run the labels again. 

 

Your big labels are now listed in order by last name. That’s even a bigger 

accomplishment. 

 

Now, let’s add a query.  

11. On the Query tab, add the following equation, which will list those employees who 

have really big pay rates. 

 

Pay Rate           > 5000 

12. Run the report.   

 

The number of big labels is now smaller because there are fewer employees with pay 

rates greater than $5000. 

13. Close the Document Viewer and the Labels screen.  

 

Your “big” document should be highlighted in the Explorer.  

14. On the File menu, select the Copy Label option. 

 

There will now be an identical copy of the document with the phrase “-1” appended to 

the document’s name. 

15. Open the copy and change the Document Name field to Label 2 Using Big Label 

Template. On the Query tab, change the equation to look for employees who have pay 

rates less than $5000.  
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16. Run the document to test it.  

 

You now know how to create two separate documents that use the same template. 

Because a document is composed of a template and query, these are not the same 

document because they have a different query. You can create other documents that use 

your “big” template as well. Each document will be unique. 

17. Close the Document Viewer.  

18. Before closing the Labels screen, delete the query row on the Query tab and remove the 

Last Name sort on the Specification tab, saving your changes.  

19. Close the Explorer.  

20. Continue with the next tutorial. 
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Tutorial 4.4 – Print Labels for a Group 

As we just saw, labels and letters for all employees can be printed within the Explorer. They 

can also be printed for any single employee or for a group of employees during an editing 

session. Here's how.  

 

First, let’s select a group of records for which to print labels.  

1. Click the Open Employee shortcut and use the Lookup Employee screen to select 

employees with a Last Name that starts with B. If you wish, use the Edit Lookup option 

after that record group is open to customize the group to contain exactly those members 

for whom you wish to print a label. 

2. On the Category Bar, click the Category Documents button. 

 

The Documents for Personal Category screen is displayed. 

3. Select the Document Type column header, so that the documents are sorted by type. 

You should be able to easily locate our label now. 

4.  Select Label 2 Using Big Label Template.  

5. Click on the Select Group button, until the button below it reads Current Group. This 

will run the labels for all the employees you designated. (Current Record will only use 

the current record, and Use Query will use the query in the document.) 

6. Click the Run button to run labels for the group. 

 

The list of employees is processed and after a brief delay the Document Viewer will be 

displayed with your labels. There should be one label for each employee in the group. 

7. Close the Document Viewer.   

8. Close the Documents for Personal Category screen. 

9. On the Tool Bar, click the Close Employee button to close the current record group. 

 

The ability to perform group functions is available when transferring records, printing 

documents, and sending email. The process is the same. Once you have a group 

identified, you can select the appropriate option from the File menu or on the Tool Bar. 

From there, you will be prompted to perform the function for the current record or for 

the entire group.  

10. Continue with the next tutorial. 

  

Label 

option does 

not work 
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Tutorial 4.5 – Copy a Template 

There are times when you might want to copy an existing template and tweak it a bit. For 

example, you might want to print the same information as on an existing label, just on a 

larger label. Or you might want similar information on the same-sized label, but you want to 

change a few fields. In these cases, you would want to copy a similar template and make 

some adjustments. Let’s see how this works.  

1. On the Templates menu, select Label Templates. 

2. Select Address Label - Avery 5160 in the list of templates on the left.  

3. On the File menu, select Copy Label Template.  

 

A new template is created with the name of Address Label - Avery 5160-1. 

4. Change the Template Name to be My All-American Label. 

 

If you wanted to change the Label Type, you could. In our case, we want to keep the 

same label size and just change on a field on the label. 

5. On the File menu, select Edit Label Template or on the Tool Bar, click the Edit Label 

Template button. 

 

The text editor is opened and your new label template is displayed. 

 

We are going to remove the Country field we added earlier. 

6. Click anywhere on the Country field placeholder. On the Field menu, select Delete 

Field. 

 

The Country field is removed from the label. 

7. Close the Label Template Editor screen, saving your changes. 

 

Let’s delete the label template we just created.  

8. On the File menu, select Delete Template or on the Tool Bar, click the Delete 

Template button. Click Yes to delete the template. 

9. Close the Label Templates screen saving your changes. 

10. This concludes this tutorial and lesson. 
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Notes
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This lesson covers the advanced features of the Text Editor while creating a letter template. 

This includes headers and footers, images, and tables. 

Tutorials 
Create a Letter Template: shows how to create a basic letter template. This includes setting 

page margins. 

Add a Header and Footer: demonstrates how to add a header and footer to a letter template. 

Insert an Image: shows how to insert one or more images into a letter template. 

Add a Table: demonstrates how to add a table to a letter template and how to add merge 

fields to the columns in the table. 
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Tutorial 5.1 – Create a Letter Template 

In the last lesson, you created a label template. In this tutorial, you are going to create a letter 

template. All of the advanced text editor features in this lesson also apply to label templates.  

1. On the Templates menu, select Letter Templates.  

2. On the Tool Bar, click the New Template button. 

3. In the Template Name field, enter My Special Letter. 

 

Like the Label Type field you learned about earlier, the Paper Size field allows you to 

pick the specific paper size you want to use. People-Trak is shipped with many standard 

paper sizes. If you need to add paper sizes, you can do so using the Maintain Paper Sizes 

utility. 

4. Leave the Paper Size field set to Letter. 

5. On the Tool Bar, click the Edit Letter Template button to start the text editor. 

 

When the Letter Template Editor screen is displayed, the editable area is shown in Page 

Layout view, which allows you to see the margins, header and footer. You have an 

option of changing to Draft view, which is sized like a word processor for full-page 

documents. We will stay in Page Layout view for our demonstration. 

6. On the Tool Bar, in the Percentage dropdown, select 75.  

 

The default page margins are one inch on all four sides. Note that the cursor is currently 

located one inch in from the top and left edges.  

7. On the File menu, select Page Setup. 

 

The Page Setup screen is displayed.  

8. Change the Top, Bottom, Left and Right margins to 1.50 inches. Click OK to make 

those changes to the page setup. 

 

The Ruler Bar is updated to reflect the new settings and the cursor is now 1.5 inches in 

from the top and left edges.  

 

When you first enter a new letter, the default Font is Arial and default Font Size is 11.  

9. On the Tool Bar, use the appropriate dropdowns to change the Font to Times New 

Roman and the Font Size to 12. 

10. Enter the following paragraph and press ENTER:  

 

This is my sample letter. In this letter, I will learn how to set margins, add a header 

and footer, insert images, and add tables.  

11. Continue with the next tutorial.  
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Tutorial 5.2 – Add a Header and Footer 

Headers and footers can only be viewed and edited when you are in Page Layout mode. You 

choose to edit a header or footer while in Draft mode, but you will be automatically switched 

into Page Layout mode to accomplish that. Let’s see how that works. 

1. On the View menu, select Draft.  

 

The letter is now shown in Draft mode. 

2. On the Edit menu, select Edit Header. 

 

The following message is displayed: 

Switching to Page Layout mode 

3. Click OK to close the message.  

 

The header area is outlined by dotted lines and includes ‘Header’ as the current text. 

This is a placeholder and you will need to change the header text to the desired phrase.  

4. Change the phrase from Header to Sample Letter.  

 

Whenever you are positioned to either the header or footer editing areas, the various 

editing and formatting options on the Tool Bar apply to the text in that area and not to 

the main editing area. So, if you wished to right justify the header (it is currently left 

justified), you can do so using the Right Justify button on the Tool Bar. Try it now. 

5. Click the Right Justify button to cause the phrase Sample Letter to be right justified 

within your header. 

6. Change the font attributes of the Sample Letter phrase to Bold and Underline using the 

appropriate buttons on the Tool Bar. (You will need to highlight the text first.) 

7. Return to the main editing area by clicking in that area.  

 

Any actions now performed using the Tool Bar buttons will apply to the main editing 

area.  

Let’s add footer. With the header or the footer, you can use the Edit Header or Footer 

options on the Edit menu, or you can just click in the header or footer areas. Let’s try the 

second option for editing the footer. 

8. Using the scroll bar, scroll down to the bottom of the letter. Click on the Footer text in 

the footer area. 

 

The footer area is now outlined by dotted lines to show that you are editing that area. As 

with the header, this is a placeholder that you can change to any desired phrase.  

9. Change the phrase to “Page:” including a space after the colon. 

 

Now we’ll see how to add page numbers to this footer (and thus to any header or footer 

you create). 

10. Verify that the cursor is just to the right of the “Page:” phrase. On the Insert menu, 

select Page Number. 
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You will see the number 1 displayed. The number 1 is not a literal; it is a variable. The 1 

is showing because you are on the first page of your letter. The number will 

automatically increment with each page of the letter. Now let’s format the page number. 

11. Highlight the footer text, and use the Font and Font Size dropdowns to change the Font 

to Times New Roman and the Font Size to 10. Then, highlight the page number portion 

of the phrase and make it Bold. 

12. Click in the main editing area.  

13. Continue with the next tutorial.  
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Tutorial 5.3 – Insert an Image 

An image can be inserted at any point in a document. Let’s see how to insert an image and 

also move it around. 

1. Click on the line just below the paragraph that you typed. 

2. On the Insert menu, click Picture.  

 

The Select File screen is displayed. This screen is used to select image files. 

3. In the PT9\SAMPLES directory of your local People-Trak drive, select the file named 

PETE&PETUNIA.JPG.  

 

The image contained in this file is displayed in your letter. It is a picture of our dear 

friend Pete the People-Stik with his gal Petunia!   

 

Once an image has been inserted into your letter, you can move the image around just as 

if it were a large character. For example, if you wish to move the image down, you can 

do so by inserting lines above the image. Try it now.    

4. Click on the line above the image and press ENTER a few times.  

 

Note that the image moves down.  

5. Now delete some of the blank lines and the image will move back up. 

 

The image can also be aligned just like text.  

6. Select the image by clicking on it. On the Tool Bar, click the Right Justify button to 

align the image with the right margin. Then click the Center button to align the image 

between the margins. Finally, use the Left Justify button to align the image with the left 

margin. 

 

The image can also be moved around with tabs.  

7. Click on the line immediately above the image. Then press DOWN ARROW to 

position the cursor to the image without actually selecting the image. Now press TAB to 

push the image to the right.  

 

The image will align with the next tab stop shown on the Ruler Bar. 

 

Now let’s see how to delete the image. 

8. Select the image by clicking on it. Then press DELETE and the image will be deleted. 

 

That’s all there is to deleting an image. 

9. Now, use the techniques used above to select the image again.  

10. Continue with the next tutorial. 
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Tutorial 5.4 – Add a Table 

A table can be inserted at any point in a document, except within an existing table. This 

tutorial will show you how to insert a table and then specify its contents. 

1. Click on the blank line below the image that you inserted in the prior tutorial.  

2. On the Table menu, select Insert Table to insert a new table.  

 

The Table Attribute screen is displayed. This screen is used to specify the number of 

rows and columns in the table. 

3. Specify 10 Rows and 4 Columns, and click OK. 

 

When you have specified the rows and columns, the table will be inserted into the letter. 

Note that an additional caption row was added and that captions were inserted for you. 

This feature speeds the process of adding caption rows considerably.  

 

We are going to create a Skills Inventory table on this letter. 

4. Change the captions to the following phrases: Skill Desc, Skill Date, Skill Level, and 

Skill Comment. In addition, change the alignment of the caption phrases from Left 

Justified to Centered. You can do this one caption at a time or you can select the entire 

caption row and do it all at once. 

 

Now we need to insert the merge fields. This looks like a daunting task as there are 40 

separate fields to insert, but there is a very nice feature in People-Trak that will make 

this task quite easy.  

5. Click in the first column of the first blank row. On the Field menu, select Insert Field 

or on the Tool Bar, click the Insert Field button to display the Field Settings screen. In 

the Field Name field, use the popup button to select the Skill Description field from the 

Training/Competency category.  

 

At this point, you would normally wish to specify a Row Modifier to indicate the first 

skill because this is the first row. However, you can take advantage of the “Autoset” 

feature within People-Trak by leaving the Row Modifier field blank.  

6. Click OK to close the screen. 

 

People-Trak automatically detects that you are inserting fields into a table and provides 

the following prompt:  

 

Autoset the column? 

7. Click Yes and see what happens. 

 

The entire column is populated with the Skill Description field and the Row Modifiers 

are automatically sequenced from one to the highest numbered row in the table.  

8. Check this by double-clicking on any of the fields.  

 

When the Field Settings screen is displayed, you can see that the both the Field Name 

and the appropriate Row Modifier have been supplied. 
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9. Repeat this process for the second column using the Skill Date field. Then complete 

column three using Skill Level and column four using Skill Comment. 

10. On the Field menu, select Show Fields. 

 

You can see all the Field Names and Row Modifier combinations that are inserted into 

the table. 

 

Now let’s see how this letter works. 

11. Close the Letter Template Editor, saving your changes. 

12. Close the Letter Templates screen, saving your changes. 

13. On the Documents menu, select Letters.  

14. On the Tool Bar, click the New Letter button.  

15. In the Letter Name field, use the popup button to select the My Special Letter we just 

created. 

16. Run the letter.  

 

You should see your header and footer, the image you inserted, and the Skills Inventory 

table you added. This letter, as you have created it, is not entirely useful unto itself, but 

you now know how to use many of the powerful features of the Letter/Label editor. 

17. Close the Document Viewer. 

18. Close the Letters screen. 

19. Close the Explorer.  

20. This concludes this tutorial and lesson. 
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Notes 
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This lesson covers how to create system templates and add them to documents. This includes 

cover sheets and header and footer annotations. It concludes by demonstration how to modify 

an existing email closing template. 

Tutorials 
Creating an Attendance Report: reviews creating an adhoc report with a query statement. 

Creating a Cover Sheet: demonstrates how to create a cover sheet using the System 

Templates Editor 

Creating Annotations: shows how to create header and footer annotations using the System 

Templates Editor. 

Adding System Templates to a Document: shows how to add System Templates to a 

document using the Document Properties screen. 

Creating an Email Closing: shows how to create an email closing using the System 

Templates Editor. 
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Tutorial 6.1 – Creating an Attendance Report 

As you have previously learned, creating a report is a much more efficient way to gather 

information about employees as opposed to going through individual records.  

In this case, we want a list of employees who have breached the company attendance policy 

by using more than 40 hours from their illness account. First, we need to make a few changes 

to ensure that we do indeed have violators. 

1. Open up Julie Carrington’s record and view her Attendance screen. 

2. Find the Illness account row and in the Current Used column, change the amount to 41 

and save your change. 

3. Repeat the same steps in Donald Stern’s record, changing the amount to 44. 

4. Close Donald’s record, saving your changes. 

5. Create a new Adhoc Report and name it Illness Account Overage. 

6. For the Explorer Category and Category, select Attendance. 

7. Select the Report Definition tab and select the following fields for our report:  

Full Name 

Attendance Account 

Hours Used 

8. On the Full Name field, select a Sort Type of Eject so that we can see each employee 

on their own page of the report. 

9. For both the Attendance Account and Hours Used fields, select a Row Modifier of 2, 

so that we are pulling data from the hours that have been used in the employee Illness 

account. 

10. On the Query tab, enter the equation shown below, using the same Row Modifier of 2 

that our report definition had: 

 

Hours Used 2         >     40 

11. Run the report and examine the evidence. 

It looks like we have two violations on our hands! 

12. Save your changes and close all screens.  

Despite the fact that the data is all there, this attendance report could use more 

substance. If it was placed on a manager’s desk as is, much would be left to the 

imagination as to what the report was for or what the next step would be. We will create 

a cover sheet for this very purpose in the next tutorial. 

13. Continue with the next tutorial. 
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Tutorial 6.2 – Creating a Cover Sheet 

1. On the Administration menu, select System Templates. 

At first glance, the System Templates screen is quite similar to the Letter Template 

screen, except it includes a Template Type field. In addition, all system templates use 

the standard text editor.  

2. Create a new System Template and give our new template the name Attendance 

Violation. 

3. In the Template Type field, select the popup to display the Select Template Type 

screen and select Cover Sheet. 

Cover Sheet templates are single page documents that are automatically pre-pended to 

documents when they run. This template enables you to create the cover sheet just the 

way you want it. For now, we will focus on creation and will show you how to add it to 

our report further on in the lesson. 

4. On the Tool Bar, click the Edit Template button to start the template editor and enter 

the following text: 

~F~ (insert Company Logo)  

According to ~F~ (insert Company Name) records, you have one or more employees 

in violation of company attendance policy. 

Please review the included report, follow the instructions provided on each page 

and return them to Human Resources.   

Thank You, 

~F~ (insert User Name)  

~F~ (insert User Title) 

You may have noticed that only the system merge fields were available to select from. 

Within system templates, you can select fields that pertain to the company and current 

user, but not anything from employee or applicant record because they would not be 

applicable here. 

5. Close the Cover Sheet Template Editor, saving your changes. We will remain in 

System Templates for the next tutorial. 

6. Continue with the next tutorial. 
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Tutorial 6.3 – Creating Annotations  

If you recall what our report looked like, there wasn’t a designated signature area. And we 

definitely do not want managers signing haphazardly wherever they choose. This issue can be 

solved by adding headers and footers, also known as annotations, to our attendance report.  

Let’s start by creating footer for employees to include their signature. 

1. Create a new System Template and name it Manager Signature. 

2. In the Template Type field, select Footer Note and start the template editor. 

3. Enter the following text: 

Manager Signature: _______________________________ 

4. Close the Footer Note Template Editor, saving your changes but remain in the System 

Template Editor. 

Just to make sure our managers understand the power of their signature on this report, it 

would be best to add a header with additional information. 

5. Create a new System Template and name it Attendance Acknowledgement. 

6. In the Template Type field, select Header Note and start the template editor. 

7. Enter the following text: 

By signing this report I acknowledge this employee’s attendance violation 

8. Save your changes and close all screens.  
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Tutorial 6.4 – Adding System Templates to a Document 

With our cover sheet and annotations finished, we are ready to add them to our report and see 

how everything works together. 

1. Open the Adhoc Reports Explorer. In the Attendance category, find and highlight the 

Illness Account Overage report, but do not run it.  

2. On the Tool Bar, click the Adhoc Report Properties button.  

The Adhoc Report Properties screen is displayed with the tabs available for this report, 

most of them which you should recognize. Notice there is a Cover Sheet tab as well as 

one named Annotations that we have yet to explore. We are going to start by adding our 

cover sheet on the Cover Sheet tab. 

3. Select the Cover Sheet tab. 

4. In the Cover Template field, click the popup button. 

The Select Template screen is displayed. You will only see Cover Sheet templates that 

are available for use, one of them being the one we just created. Templates available will 

depend on the template type selected as you will see when we set the header and footer 

for this report. 

5. Select our Attendance Violation cover sheet and return to the Adhoc Report 

Properties screen.  

Now we can start to add some annotations. 

6. Select the Annotations tab. 

7. In the Header Template field, click the popup button and select the Attendance 

Acknowledgement header. 

8. In the Footer Template field, click the popup button and select the Manager Signature 

footer. 

For both the header and footer there are checkboxes that will repeat the header and 

footer on each page of the report when they are selected. If they are not selected, they 

will appear on the first page only. We want our header and footer on all pages. 

9. Select the Repeat Header and Repeat Footer checkboxes 

10. Save your changes, return to the document explorer and run our report. 

Our cover sheet shows up as the first page of our document and if we look through the 

actual report pages, we will see the headers and footers perfectly placed as if they had 

always been there. The report is ready for manager distribution! 

11. Continue with the next tutorial. 
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Tutorial 6.5 – Creating an Email Closing  

Email closings add a professional touch to email messages and For now are going to add 

some pizzazz to an existing email closing and see how to use the closing in a future lesson. 

1. On the Administration menu, select System Templates. 

2. Select Standard Email Closing in the list of templates on the left.  

3. On the File menu, select Edit Template or on the Tool Bar, click the Edit Template 

button to start the text editor. 

First, let’s take a look at what fields we will be working with. 

4. On the Field menu, select Show Fields to display the field names.  

The email closing already includes the name and title of the system user. We are going 

to go ahead and add the system user’s email address and phone number. 

5. Select Show Fields again to change the field names back to placeholders.  

6. Click on the first line after the last placeholder.  

7. On the Field menu, select Insert Field or on the Tool Bar, click the Insert Field (~F~) 

button to start the insert.   

 

The Select Field screen is displayed. 

8. Select User Email. Click OK to insert the field. 

9. On the next line, insert the User Telephone field. 

10. Close the Email Closing Template Editor screen, saving your changes.  

11. Close the System Templates screen, saving your changes. 

An email closing is assigned in User Setup for each user. Since we modified an existing 

template, all we need to do is confirm that it has been assigned to the DEMO user. 

12. On the Setup menu, select User Setup. 

13. Select the Preferences tab. 

It looks like the Standard Email Closing has already been assigned to the DEMO user, 

so no need for us to make changes.  

14. Close User Setup. 

15. Continue with the next tutorial. 
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This lesson covers the steps required to create a form template, which allows you to easily 

output People-Trak data on any form. It also demonstrates how to create complex custom 

forms for reporting purposes. 

Tutorials 
Create a Form Template: shows how to create a form template by selecting the PDF form 

to use and the fields to be included on the form.  

Using Preview Mode: demonstrates how to move some of the objects you have placed on the 

form template. 

Object Properties: demonstrates how to make changes to the location and size of objects on 

a form template by using the Object Properties screen. 

Produce a Form Document: shows how to produce a form document that uses the form 

template and a query you specify. 

Create a Form Template 2: demonstrates how to create a complex custom form for 

reporting purposes.  

Create a Form Template 3: reviews how to create a form template by selecting the PDF 

form to use and placing fields to be included on the form. 

Create a Form Template 4: shows how to create a form template by selecting an edited 

PDF form to use and the fields to be included on the form. 
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Tutorial 7.1 – Create a Form Template  

A form document allows you to easily output People-Trak data on any form you desire. The 

first step in preparing a form document is to create the form template on which it is based. 

Let’s get started. 

1. On the Templates menu, select Form Templates.  

 

The Form Templates screen is displayed. 

2. On the File menu, select New Form Template or on the Tool Bar, click the New Form 

Template button to start a new form template.  

 

A default name will be assigned. The name is NEW-#, where “#” is the next available, 

unused number 

3. In the Form Name field, enter Emergency Contact Form.  

4. In the Category field, select the Personal category. 

5. Leave the Paper Size field set to Letter because that is the correct size of our form. 

 

The Page Width and Page Height fields are informational and show those dimensions in 

inches. 

6. For this tutorial, leave the Print Form check box selected so the background form will be 

printed. Our form takes up the entire page, so we need to make sure the margin boundary 

is set to 0. 

7. In the Margins field, click the popup. 

 

As you can see, you can select a margin from 0 to 1 inch in ¼ increments.  

8. Select 0.  

Now, let’s select the PDF form we want to use.  

9. Click the Select Form button to start the process. 

 

The Select File screen is displayed. Only PDF files will be shown as you browse. 

10. In the PT9\ SAMPLES directory of your local People-Trak drive, select the file named 

EMERGENCY CONTACT FORM.PDF.  

 

The Print Form field enables a powerful feature within People-Trak. You need to select a 

background form, as we have, to allow you to align fields on the form. However, it is not 

necessary to actually print the background form when the form is produced. For example, 

if you create a form for payroll checks, you use a generic background form to align the 

fields. When the checks are actually produced, you place pre-printed forms in the printer 

and do not print the background form itself. If you are not using pre-printed forms, you 

place blank paper in the printer and print both the data and the background form. 

11. Click the Preview button and take a look at the form so far, noting the format and the 

fields that need to be filled in. 
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12. Close preview mode and return to the Form Templates screen. We will revisit preview 

mode once we have some objects to manipulate. 

 

The Objects grid is where the fields that are to be placed on the form are selected. You 

can select as many fields as you need. You can use row and field modifiers as necessary 

to select the specific fields you need. 

13. In the Object Type column on the first blank row in the grid, select the popup button to 

display a list of the valid object types.  

 

As you can see, there are several object types that we can use for a form template. The 

template we are currently working on will be using field objects. We will take a look at 

other object types in a future lesson. 

14. Select the Field object. 

15. In the Object Name column, click the popup button to display a list of the fields in the 

Personnel Management module. Select the Full Name field.  

 

The Caption column is automatically set to the caption currently associated with this 

field. (In the case of the Full Name field, the caption is set to Full Name.) This can be 

changed, if desired, but we have no need to make a change at this time, so just leave the 

field as is. 

 

The Left and Top fields are set to -1 to let the system know that these coordinates need to 

be calculated. This calculation will happen when first going into preview mode or when 

saving. The Width and Height fields contain the width and height of the field in pixels. 

We’ll learn more about these attributes later.  

To save you some time, here is a list of the rest of the fields needed for our form.  

16. For Object Type, select Field and select the following Field Names: 

Address 1 

Address 2 

City 

State 

Zip Code 

Contact 1 Name 

Contact 1 Relation 

Contact 1Address 1 

Contact 1Address 2 

Contact 1City 

Contact 1State 

Contact 1Zip  

17. Select the Preview button. 

 

The names of the fields you have placed on the form are listed in the Object dropdown. 

The fields themselves are listed down the left side of the form, but that isn’t where we 

need them to be. We need to place the field objects into their respective positions on the 

form, which is a task for the next lesson. 

18. Remain in preview mode and continue with the next tutorial. 
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Tutorial 7.2 – Using Preview Mode 

In the previous lesson, we used preview mode to take a peek at what our form template 

looked like. Now we are going to use it to actually move some of the objects you have placed 

on the form template. 

1. Select Preview to view our form template in preview mode if you have not already done 

so. 

 

Let’s start by using the mouse to drag an object. 

2. Click on the Full Name field to activate it. Then click and drag it down to its respective 

place on the PDF form.  

 

When you moved the Full Name field, the caption did not move with it. There is actually 

a way to have the field and its caption move together if you choose. Let’s try it. 

3. First, move the Full Name field back down to where it used to be, lined up with the Full 

Name caption. Click in the empty area off to the right of the Full Name field to deselect 

it. 

4. This time, click on the Full Name field using the right mouse button. 

 

Both the Full Name field and its caption are now highlighted. 

5. Click and drag the Full Name field and its caption so that once again, the field is placed 

in its proper location on the form. 

You will notice that the caption is overlaying the text for that field on the form.  We will 

remove all captions once we have all of our fields further down the road. 

 

Now that the Full Name field has been moved, you can see that we have some work 

ahead of us, moving each field to where it belongs. We can make this process a bit faster 

by moving more than one object at a time. 

 

The trick to dragging multiple objects is to select them all first. Multiple objects are 

selected by clicking on them while holding down the CTRL key. With the Field object 

you can automatically select its caption as we have seen by right clicking on the field. 

This time let’s do the same thing by using the CTRL key with the Name field for our 

emergency contact. 

6. Click on the Name field and then hold down the CTRL key and click on the caption for 

the Name field.  

 

Both the field and the caption are selected. But did you know that this works with 

multiple fields and captions as well? 

7. While still holding down the CTRL key, select the Relation field and its caption.  

8. Now that these fields and captions are selected, move these fields so that the Name field 

and its caption are properly placed on the form. As you can see, the Relation field and 

caption are almost where they should be, but still require a bit of adjusting. 

 

Sometimes, in an operation such as this, the mouse can be difficult to use. It can seem 

impossible to get the objects to move just one pixel and suddenly your normally supple 



Form Templates 

 

 What’s New in Documents and Reporting     69 
 

wrist feels like it has a cast on. So, People-Trak provides a “nudge” feature. Nudging 

allows you to use keystrokes to move an object or a collection of objects one pixel at a 

time. Here is how it works. 

9. Select the Relation field and its caption. Now hold down the CTRL key and then press 

the UP ARROW key to nudge the objects up. Now press the DOWN ARROW key to 

nudge the objects down. To move left and right, use the LEFT and RIGHT ARROW 

keys.  

 

You can use this method to move objects into the precise location you desire without 

“wrist lock”. 

10. Now position the rest of the fields. 

11. Close preview mode.  

 

We don’t need the captions on any of our fields because the form itself already has the 

captions on it. All we need to do is clear the captions for all our fields. 

12. For each of the Field objects, clear the Caption field. 

13. Click the Preview button. 

Now the form looks much better. 

14. Close preview mode. 

 

All of the moving tasks that you just performed were recorded in the object’s property 

settings. In a future lesson we will take a look at how to see these properties for each 

object on the custom screen. But before we do that, let’s see what our form template 

looks like as a form document. 

15. Continue with the next tutorial. 
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Tutorial 7.3 – Produce a Form Document 

Now that we have our form template created, we are ready to produce the output form. 

1. On the Documents menu, select Forms. 

2. On the Tool Bar, click the New Form button to create a new document.  

 

The Forms screen is displayed. 

3. In the Document Name field, enter Emergency Contact Form and place the document 

in any desired Explorer Category. Set the Category field to Personal. 

4. In the Form Name field, click the popup button to display a list of the available form 

templates. Select Emergency Contact Form. 

5. On the Tool Bar, click the Run Form button to run this form. 

 

Since a query was not specified, an Emergency Contact Form is generated for each 

employee, and the form for the first employee is displayed in the Document Viewer. You 

can move between the records using techniques you have learned before. 

6. Close the Document Viewer and the Forms screen, saving your changes. 

7. Close the Explorer. 

 

Output forms can also be produced when editing records just like letters and other 

documents.  

8. Open Donald Stern’s record and remain on the Personal screen. 

9. On the Category Bar, click the Category Documents button. 

 

The Documents for Personal Category screen is displayed. 

The Select Group is defaulted to Current Record, so all we need to do is select our form. 

10. Click on the Document Type column header to sort the documents by type. Within the 

forms that show up, select the Emergency Contacts Form we just created. 

11. Click the Run button to run the form for the current record. 

 

The form will be produced for Donald Stern and displayed in the Document Viewer. We 

could have just as easily selected Use Group and produced a form for each employee in 

the group. 

12. Close the Document Viewer.  

13. Close the Documents for Personal Category screen. 

14. Close Donald Stern’s record. 

15. Continue with the next tutorial. 
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Tutorial 7.4 – Create a Form Template 2 

You have seen how to create a form template based on a form image. You can also create a 

form template for reporting purposes. These form templates may or may not use a form 

image. In our example, we are going to create a form template that includes employee skills. 

1. On the Templates menu, select Form Templates and create a new form template. 

2. In the Form Name field, enter Employee Skills and select Training/Competency for 

the Category field. 

3. Leave the Paper Size field set to Letter. 

4. In the Margins field, enter 0.25, which will create a ¼ margin around the whole form.  

Let’s start adding objects to our form template. The Border object allows you to create a 

nice heading and border for your form template. Let’s add one to our form template. 

5. In the Object Type column on the first blank row in the grid, select the popup button to 

display a list of the valid object types.  

6. Select a Border for the first object. 

 

The Caption defaults to the name of your form but can be overridden, if you choose. 

 

Now, let’s add a frame and fields for the employee information. 

7. Add a Frame object with a Caption of Employee Information. 

8. Add the Employee ID and Full Name fields below that. 

 

Next, we will add the skills grid. 

9. Add a Grid object and use the popup in the Object Name column to select the Skills 

Grid.  

10. Click Preview to take a look at our form template. 

 

We definitely need to do some rearranging and resizing before using our template in a 

form. First of all, the Skills grid is too narrow. Let’s increase its width to fit within our 

form borders. 

11. Either select Grid –Skills Grid in the Object dropdown or click on the Skills grid to 

activate it.  

12. Now move the cursor to the right edge of the grid. When the cursor crosses the right 

edge, it will change to a left/right arrow. With the left/right arrow displayed, hold down 

the mouse button and carefully drag the right edge of the grid to the right. We do not 

want to move the grid; we want to make the grid wider. 

13. Increase the width of the grid until it fits just within the borders of the form template. 

Chances are that the column headers on the grid may need to be resized after our last 

adjustment. 
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14. Click in the header area of the Comment column of the grid, which will highlight that 

header. Hover over the column separator line between that column and the Acquisition 

Date column. The cursor will change to a left/right arrow. Click and hold the mouse 

button down and drag the column to the right until the Acquisition Date column has 

expanded to a size that accommodates the heading text.  

15. Reselect the whole grid and move it down the form so that it is placed directly under the 

frame object that includes the Employee ID and Full Name fields.  

 

You may have noticed when moving the grid, it stayed within the margins set by the 

border. Let’s take a closer look at this.  

16. Select the Skills grid for activation. With your mouse, move the grid a bit past the right 

border of the form template and release it.  

 

Immediately, the Enrollment grid is “snapped” back into the margins set by the form 

border. Within form templates, there is a snap to edge feature that aligns objects to the 

left and right margins. 

Our last grid modification will be decreasing the number of rows within Object 

Properties. 

17. Select the Skills grid and press the F1 key to display the Object Properties screen. 

 

Take a look at the Height field and note the number of rows that our grid has. 

18. Change the Height to 10 and click Apply to apply the change. Click anywhere off the 

grid to be able to see it again. 

Our grid is a smaller size and is exactly how we want it for our form. Let’s take a look at 

how changing the properties of a field object are just as easy as changing grid object 

properties. 

19. Select the Full Name field and press the F1 key to display the Field Object Properties 

screen.  

20. Record the value of the Top field and close Field Object Properties. 

21. Use your mouse to drag the Full Name field towards the top of the form.  

22. Press the F1 key to display the Field Object Properties screen again. 

 

Note that the value of the Top field has been updated to reflect the movement of the 

object. To restore the field to its original place, simply update the coordinate back to the 

value you recorded.  

23. In the Top field, enter the number you recorded. Click the Apply button to apply the 

change. Make any necessary adjustments to move it back into place. 

24. Close Preview mode and the Form Templates screen, saving your changes. 

25. On the Documents menu, select Forms. On the Tool Bar, click the New Form button to 

create a new document. 

26. In the Document Name field, enter Employee Skills and place the document in any 

desired Explorer Category. Set the Category to Training/Competency 
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27. In the Form Name field, click the popup button to display a list of the available form 

templates. Select the Employee Skills template. 

28. On the Tool Bar, click the Run Form button to run this form. 

 

You can see how easy it is to create and edit a very complex form with any information 

available in People-Trak.  

29. Close the Forms screen, without saving your changes. 

30. Continue with the next tutorial. 
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Tutorial 7.5 – Create a Form Template 3 

Now that we have learned about the many features used to create and edit form templates, we 

can put our skills to use while building a form template that uses a complex background form 

with multiple fields that need to be populated. 

1. Using what you have learned in prior lessons, create a new form template. 

2. In the Form Name field, enter Application for Employment. 

3. In the Category field, select the Personal category. 

4. Leave the Paper Size field set to Letter and the Print Form check box selected. 

5. In the Margins field, enter 0. 

6. Click the Select Form button to display the Select File screen. 

7. In the PT9\SAMPLES directory of your local People-Trak drive, select the file named 

APPLICANT INFORMATION 2.PDF.  
 

To save time, we will start you off with the first three field objects that need to be added 

to the Objects grid. 

8. For Object Type, select Field and select the following Field Names: 

 

Former Employer 

Employment Start Date 

Employment End Date 

9. Click the Preview button. 

10.  Using what you have learned in prior lessons, move the field objects into their respective 

places on the form. 

 

 As you can see, there are more field objects that need to be added to the Object grid, not 

to mention all of the moving around and resizing that will need to be done. We have 

some tedious and time consuming work ahead!  

 

Let us spare you the extra work as we move on to the next tutorial, which will provide an 

alternative to the drag and drop process. 

11. Close preview mode without saving and continue with the next tutorial. 

  



Form Templates 

 

 What’s New in Documents and Reporting     75 
 

Tutorial 7.6 – Create a Form Template 4 

As we just witnessed, dragging and dropping multiple objects can get a bit out of control. In 

this lesson, you will see how using a PDF form that has been edited to accommodate People-

Trak fields makes creating a form template that much easier. 

1. Using what you have learned in prior lessons, create a new form template and name it 

New Application for Employment. 

2. In the Category field, select the Personal category.  

3. Leave the Paper Size field set to Letter and the Print Form check box selected. 

4. In the Margins field, enter 0.  

5. Click the Select Form button to display the Select File screen. 

6. In the PT9\SAMPLES directory of your local People-Trak drive, select the file named 

APPLICANT INFORMATION 2 EDIT.PDF 

7. Click the Preview button and take a look at the form so far. 

 

Does this form look familiar to you? It should. As you can see, the form we used in the 

last tutorial has been edited in such a way that the Previous Employment fields are now 

one large blank area. We will use this to our advantage. 

8. Close Preview mode. 

9. Add a Grid object and use the popup in the Field Name column to select the 

Employment History grid.  

 

The fields in that grid are automatically filled in on the rows below.  

10. Click the Preview button. 

11. If the Employment History grid is not already selected, select it for activation and move 

and position the grid so that it fits within the available blank space of the Previous 

Employment area. 

Voila! We saved a bunch of time by not moving around fields and captions and our form 

looks pretty good with the grid we added. Now to see what our masterpiece looks like 

when it is run as a form. 

12. Close Preview mode, saving your changes. 

13. Close the Form Templates screen, saving your changes. 

14. On the Documents menu, select Forms. 

15. On the Tool Bar, click the New Form button to create a new document.  

 

The Forms screen is displayed.  

16. In the Document Name field, enter New Application and place the document in any 

desired Explorer Category. Leave the Category field set to User. 
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17. In the Form Name field, click the popup button to display a list of the available form 

templates and select the New Application for Employment form. 

18. On the Tool Bar, click the Run Form button to run this form. 

19. Close the Forms screen, without saving your changes. 

20. Exit People-Trak. 

21. This concludes this tutorial and lesson. 

  



Form Templates 
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